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Saving the Book as a Template

Once you have finished the book, you may want to save it as a
template for reuse to create more books of the same format. To do this,
just delete the main story, leaving the connected text �ames, headers
and footers, covers, table of contents, and the index if it has one.

From the File menu, use  Save
as… and select PagePlus Template
�om the Files of Type: drop list.
The template will automatically be
saved in your Application Data
folder for PagePlus and will then
appear in the Startup Assistant on
starting a New Publication.

Templates can be saved else-
where, but then they won’t appear in the Startup Assistant.

Now close the current (template) publication and reopen the original
book if you need to work on it some more.

On starting a new publica-
tion, you’re ready to start �ping
or importing the main story for
the next publication, and modi�-
ing the cover design as required.

If importing files �om Word
or LibreOffice, I recommend
importing without forma�ing,
then applying the Body Text s�le
to the whole book in PagePlus.

A�er forma�ing a few headings with Heading 1, Heading 2, etc., the
Table of Contents can be regenerated to keep �ack of progress, and a�er
marking words for the index, the index can be regenerated for the new
publication. Edit headers on the master page and edit the running
headers on the recto pages as editing nears completion.

Most of my publications share a similar cover design for books by
the same author as part of my “House S�le.” Many of them use my Pali
font. Creating a new publication involves a bare minimum of refor-
ma�ing so my time and energy can be focused on writing and editing.
For my purposes, clari� of the content is the most important, but I also
spend time to tighten forma�ing to reduce potential printing costs.
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Designing a Book in PagePlus

I assume that the reason why there are no Book Templates bundled
with PagePlus is because there is no standard layout for books. It is best
to design your own template, then reuse it for your other publications,
or for other publications by the same author.

This tutorial aims to explain the design process and the methods that
I use for my own publications. I hope it will make it easier to design your
own template, while avoiding some of the common pitfalls.

Publication Setup

The first decision is to choose the page size. This may be specified by
the printing company who will be producing the book, or dictated by
the size of paper that your desktop printer can handle if it’s to be
produced in small numbers. If it’s to be a PDF publication, the page size
can any convenient size, bearing in mind that it will be read in a PDF
viewer, or printed on A4 or US Le�er paper.

The next decision is about binding. Will it be a staple-bound book
or will it be perfect bound? If the former, then in Publication Setup,
Paper, Regular/Booklet publications, select “Side-fold Booklet.” PagePlus
will impose the pages, so that pp 64 and 1, pp 2 and 63, etc., are printed
on one sheet. For perfect binding, choose Booklet, None, to print page
2 on the back of page 1, etc. In both cases, facing pages, dual master pages
is usually the most convenient option for laying out the book as it will
appear to the readers, with the cover and page 1 on the right, page 2 on
the le�, page 3 on the right, etc.

Thirdly, how big do the margins need to be for �imming and stapling?
Do they need to be wider on the outside or the inside? Is the top margin
able to accommodate the headers, and the bo�om margin adequate for
the footer or page number? I design my margins to position the header
above the top margin, because text will be flowed to fit inside the margins
by default. If the page number is at bo�om cen�e, then I position its
baseline on the bo�om margin, so that it aligns with the bo�om of the
text on the facing page, or slightly lower. How you design the page layout
is very much a personal choice. Look at some books, and decide what
you think looks best. Then take that as a guide to designing your template.
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Typefaces and Fonts

Many long books have been wri�en on Typography. If you don’t
know which �peface to choose, do your research because the decision
is not one that should be changed late in the design process. A slightly
different font will entail a huge amount of work to ensure that the pages
break neatly again, chapters begin in the right place, etc. Updating the
Table of Contents and Index will be the least of your worries.

A �peface for a book should have at least four �pe s�les: Regular,
Italics, Bold, and Bold Italics. If your chosen �peface doesn’t have a bold
or italic s�le, then don’t use bold or italics anywhere in your book because

Windows will generate a false s�le that will look bad, and cause problems
when publishing to PDF.

Having decided on the �peface, you then need to choose a font.
There are countless clones of the most popular �pefaces. You don’t have
to pay serious money to buy professional �pefaces, but you might regret
the choice if you use a poor quali� clone. Expensive professional fonts
can also be a poor choice if they have res�icted license embedding.

The �peface used for this publication is “Sukhumala,” which is my
�ee OpenType version of Sort Mills Goudy. The Goudy �peface is
graceful and ex�emely popular for printed publications. Run through
this checklist to see if your chosen font is adequate for the intended
publication:

Legibili�. Can it be read easily by your target audience?
Licensing Rights. Can it be embedded in PDF files?
Glyph Coverage. Does it include all of the accents, symbols, and

punctuation that you need?
Type S�les. Does it include the full range of s�les and weights that

you want to use? Will you use the same �peface for headings, or if not,
which �peface will work best with the body text font?

OpenType Features. Does it included Smϊ̆́ll Cϊ̆́pitϊ̆́ls, Ordinals
(1��, 2��, 3��), ligatures (ff fi, ffi, etc.), Fractions (1⁄ῐ̔́) or Alternative Fractions
(�, �) if you need to use them?

Leading, Justification, Hyphenation, and Tracking

This affects what is known as “copyfit” in the printing �ade. The
cost of printing hard copies, or the number of pages that can be stapled,
may limit your choice of �pefaces and sizes. If your target audience is

http://www.amazon.com/Typography-Graphic-Design-Books/b?ie=UTF8&node=1875
http://www.softerviews.org/Fonts.html#Sukhumala


Leading, Justification, Hyphenation, and Tracking 3

older readers or the very young, it’s not advisable to use a small font size
to reduce printing costs. However, some �pefaces are more legible than
others at the same point size. I find that 11 point text is the smallest that
I can read comfortably, or 10 point if the font is Verdana.

There are ways of fi�ing more words on the same number of pages,
without compromising legibili� too much. Because I design my publica-
tions for reproduction on a desktop laser printer, I use all available �icks
of the �ade to use fewer pages:

Leading. The default line-spacing for this 11 point Sukhumala font
is 14.3 points, or 130% of the point size. However, it works quite well
for English text if the line-spacing is reduced to 120% of point size. If it
were being used for Vietnamese text, this would not be advisable due
to the large number of accents. It was originally designed for Buddhist
publications, with possible use for Vietnamese in mind.

Justification. Books o�en use fully justified text. PagePlus will remove
space between words to fit more text on a line. If the minimum se�ing
in Format, Paragraph, Justification is reduced to 97% it will also reduce
the spacing between le�ers. I use a maximum value of 103%.

Optical Justification. This allows for the fact that the eye automati-
cally compensates for the different le�er shapes when they occur at the
end or beginning of a line of text. If Optical Justification is enabled in
Format, Character, Spacing; le�ers like A, T, V, W, and punctuation will
be moved slightly into the margin, i.e. outside of the text �ame. In
PagePlus, when the text �ames are displayed, this will make the margins
look ragged, however, when printed, the s�aight lines forming the Text
Frame boundaries won’t be printed, and the ragged margins will now
appear s�aighter than they would without Optical Justification.

Hyphenation. Automatic hyphenation will allow long words to break
at the margin. If you prefer to have less �equent hyphenation, or none
at all, change the se�ings in Format, Paragraph, Hyphenation. I increase
the defaults for Minimum word size, and set the minimum number of
le�ers to break to three instead of only two.

Tracking. This refers to the spacing between le�ers. PagePlus calls it
“Condensed or Expanded Spacing.” It o�en happens that a paragraph has

only a few words on the last line. By reducing the �acking with the shortcut
C�l + Alt + Le� Cursor, PagePlus will adjust the �acking in increments
of 0.1%. O�en, one can reduce a paragraph by one line by adjusting the
�acking by 0.1% to 1%, which readers won’t even notice. If it’s really
necessary to fit the last line of the last paragraph onto the last page in a

http://www.amazon.com/Typography-Graphic-Design-Books/b?ie=UTF8&node=1875
http://www.softerviews.org/Fonts.html#Sukhumala
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chapter, you may find that reducing the �acking by as much as 3% is
acceptable.1 The �acking can also sometimes be increased to force a few
more words to flow onto the last line of a page, filling an emp� line.

Kerning. This refers to the spacing between individual le�er pairs.
Kerning pairs are defined in the font with kerning tables. There are two
�pes of kerning tables: kern and GPOS. The former kerning tables are
now superseded by the la�er. The latest version, PagePlus X9, now
supports GPOS kerning. If you choose a font with only GPOS kerning
tables (e.g. Linux fonts or Adobe Pro fonts), earlier versions won’t be
able to use Automatic kerning. Automatic kerning should be enabled in
the paragraph s�le for text above a certain size. The default of 16 points
is too high. Even footnote text will benefit �om kerning, and Body Text
will use less space if kerned without looking cramped, as long as the font
designer did a good job. By using all of the above techniques to fine-tune
spacing, a book that was 66 or 67 pages, can be made to fit on 64 pages,
without changing the font size or choosing a less legible �peface.

Project Management

How will you get the text, images, and other content into your book?
Is the text already wri�en in a word-processor, will it be copied �om a PDF
file, or will you �pe it yourself as you go? Are you accepting con�ibutions
�om a number of different con�ibutors, or only working with one?

In my experience, it is best to import the text without retaining the
forma�ing (clear the checkbox when using Insert, Text File, to import a
file �om a word-processor. Then apply paragraph s�les within PagePlus.
Just select all, apply Body Text, then work your way through, while deciding
which heading level to apply to each heading paragraph. If you need an
alternative paragraph s�le to body text, for a quotation or numbered list
for example, then apply the desired paragraph se�ings to that paragraph,
and create a new s�le based on Body Text for the selected text.

If importing con�ibutions �om various authors, ask them
to use the Open Document format of OpenOffice or Libre-
Office. Footnotes, Endnotes, Index marks, and Tables should
import without issues. Ask them not to bother with forma�ing,
and to supply diagrams as separate files. LibreOffice can export

1 The �acking of this paragraph is reduced by 0.9% to fit one more line. The paragraph
below this one is condensed by just 0.1%, enabling the last word “�peface” to move up
to the previous line, saving 1 line in 14 or 7%.

http://www.softerviews.org/IrfanView.html
http://www.softerviews.org/IrfanView.html
http://www.softerviews.org/IrfanView.html
http://www.softerviews.org/FastStoneViewer.html#PhotoResizer
http://www.softerviews.org/Images.html
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drawings in SVG (Scalable Vector Graphics) format, like the question
mark graphic in this paragraph. PagePlus can o�en import these with
be�er results than WMF or EPS. Very long tables are best split into
several single page files wherever possible.

Only in exceptional cases should you use BookPlus. It is a legacy
feature �om earlier versions of PagePlus, which did not have page
numbering sections, or mixed orientations within a single publication.
It is far easier to edit the content globally if it is all in one publication.
BookPlus might be a sensible choice for very long publications with a
large numbers of images, drawings, tables and charts, but most problems
can be avoided by following these simple steps:

Create a project folder for all images to be used in your publication.
Optimise all images to the number of pixels needed for

the placed size at 300 dpi. For a full A4 page allowing for
some bleed, that would be about 12" x 8.5" or no more
than 3,600 x 2,550 pixels. If any images are bigger than
that — and images �om modern cameras may be
significantly bigger — resample them using Irfan-
View, FastStone PhotoResizer, or a similar utili�,
and save the copies in your project folder, leaving the originals untouched.
If your publication is intended for publishing on the Internet as a PDF,
then use only as much JPEG compression as you find acceptable to keep
file sizes small without unsightly JPG artefacts. The image of a Chindit
above was compressed �om IrfanView using a medium se�ing of 75 for
use on this web page. If you zoom in close, you can see the artefacts.

Link all images to your publication — do not embed them. Embed-
ding images only bloats your PagePlus file, making it slower to load, save,
and backup. Many issues that I have seen reported on the support forums
about corrupted PagePlus files were apparently a result of users embed-
ding lots of large images. Perhaps they switched off their PC while
PagePlus was still busy saving the file! It is hard to know for sure, but if
linking images might avoid some problems it is be�er to use it. If you do
need to �ansfer the project to another PC, then use the Save as package
option on the file menu. That will embed all images and fonts too if
necessary. Make a backup of the project folder and save it in a safe place,
e.g. on an external drive or on DropBox. Think about how you would
recover your work a�er a fire, computer the�, or hard drive failure.

Images that flow with the text should be anchored inline. Images that
are wider or higher than the text �ame will be resized to fit, as will images

http://www.softerviews.org/IrfanView.html
http://www.softerviews.org/IrfanView.html
http://www.softerviews.org/IrfanView.html
http://www.softerviews.org/FastStoneViewer.html#PhotoResizer
http://www.softerviews.org/Images.html
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that are much bigger than the page. Use the Transform Tab to check that
images are placed at 100%. If they are not, then data is being thrown away,
or images will be resampled on publishing, resulting in loss of sharpness.

When publishing to PDF, clear the “Downsample image” checkbox on the
Compression Tab of the Publish to PDF dialogue to leave your carefully
optimised images untouched. The Table opposite shows the benefits of
optimising image compression to suit the intended purpose.

Wide tables that need to be rotated on the page in the printed
publication are difficult to edit in the normal design mode. Right-click
on any rotated tables or text objects to edit them in the Logo Studio.

When opened in Logo Studio the rotation will be removed automatically
so that you can read and edit the text normally. You might also want to
use this technique for maps with text objects, arrows, lines, etc., even if
they are not rotated. It will group the objects and stop them ge�ing
moved accidentally, while remaining easy to edit simply by double-
clicking on the Logo object.

For sharing projects with other collaborators, use the Save As
Package… option on the file menu to embed all linked content and fonts
to ensure that they have everything that they need. When they open the
package they will be asked to select a folder in which to ex�act the
embedded content. A�er that, on saving it, the file becomes a regular
publication with the content linked. The file size is greatly reduced, and
the file again loads and saves in just a few seconds.

Page Numbering Sections

All recent versions of PagePlus support page numbering sections. A
common requirement is to have no page numbers for the cover and inside
cover pages, Roman numerals for the �ont ma�er, Arabic numerals for
the body of the book, and perhaps another section for the appendix.

To add a new page numbering section, �om the Format menu, open
the Page Number Format dialogue and click on Add. Type the publication
page number where you want the new section to start, and select the
page numbering s�le �om the radio bu�ons. Then deselect the “Con-
tinue �om previous section” checkbox and enter the starting number
for the new section (which is 1 in most cases).

I have assigned the shortcut C�l+# to insert a page number code,
and Alt+# to open the Page Number Format dialogue. See my tutorial
on Customising Keyboard Shortcuts for details.

http://www.softerviews.org/Customised%20Keyboard%20Shortcuts-1.ppp
http://bellard.org/bpg/lena.html
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new BPG format might take over due to its better
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8 Designing A Book in PagePlus

Configuring S�les

PagePlus supports hierarchical s�les. Designing paragraph s�les
carefully not only saves a lot of error-prone editing, it also ensures
consistent design throughout the publication. Open the Text S�le Pale�e
�om the Format menu to organise the s�les that you plan to use in this
publication. See my tutorial on Customising PagePlus for details.

Modi� the Normal paragraph s�le to use the font that you plan to
use for Body Text. If it’s not already cleared, clear the “Allow for text
advances” checkbox on the paragraph spacing tab. Set the line-spacing
to 120% of pointsize or whatever value best suits your chosen font. Most
other se�ings can be le� as they are: hyphenation, optical justification
disabled, widow/orphan con�ol enabled, etc.

Modi� the Body Text s�le to make sure that it is based on the
Normal paragraph s�le, and that the s�le for the following para-
graph is also Body Text. These se�ings are on the General Tab of
the Text S�le dialogue when modi�ing s�les.

Modi� the Headings s�le to base it on the Normal paragraph s�le.
Headings might use a different font to Body Text, or the same font, but
different before and a�er paragraph spacing.

Modi� all other Heading s�les to base them on the Headings s�le.
Modi� other s�les like Footnote Text to base them on Body Text.
Remove all unused s�les to make it easier to select s�les �om the

S�les drop list or the Text S�les Tab.
Assign shortcut keys to s�les in Tools, Options, User Interface,

Keyboard, Text Editing context, S�les. If you haven’t previously edited
the keyboard shortcuts, you will first have to create a new Keyboard
Profile and select it. I use Shortcuts like C�l + Shi� + 1 to apply the
Heading 1 s�le, C�l + Shi� + 0 to apply Body Text, etc.

Setup the Baseline Grid

Using the baseline grid is optional, but it helps by aligning the
baseline of text on facing pages for a more professional appearance.

Enable the grid in Tools, Options, Baseline Grid. The value for Grid
Spacing should be the same as the default line-spacing for the Body Text
s�le, which for this publication is 11 x 120% = 13.2 points.

The Start position for the grid can be relative to the Top Margin or
relative to the top of the page. If the Heading 1 s�le is the first paragraph

http://www.softerviews.org/Customising%20PagePlus.ppp
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on a page, and if that s�le is aligned to the baseline grid, it should snap
to the first grid line. If the Start Position is at the top margin, any
paragraphs with line-spacing greater than 13.2 points will only snap
to the second grid line, thus leaving a large gap. So, set the start position
to the line-spacing for the largest heading, e.g. 16 x 120% = 20.8 points,
or disable Align to baseline grid for Heading 1 (Chapter level headings),
but enable it for Heading 2 s�le and set the Start Position of the
Baseline Grid to suit that: i.e. 14 x 120% = 18.2 points. That is what I
have done for this publication. Where the first line of a page is Body
Text that will also align to the first line at 18.2 points �om the top
margin, and not 13.2 points �om the top of the text �ame as it would
do without baseline grid alignment.

The other se�ing is the Display Threshold, which is the zoom level
at which the baseline grid is displayed (when not working in Clean
Design mode or Trimmed Mode). The default is 70% so the grid will be
visible while editing text at 100%, though probably not when viewing
at the Fit to Page se�ing. I find the grid dis�acting, so I change this se�ing
to 200%. I also change the baseline grid colour to a pale blue. The baseline
grid can be displayed in �ont of graphics, but the default is to send it to
the back behind any object with a fill.

Be aware, if using the Baseline Grid, that it’s not supported in
versions of PagePlus before X8, so the forma�ing of publications will be
broken on opening a publication using a Baseline Grid in PagePlus X7
or earlier. This may cause problems if collaborating with others using
older versions, so avoid using it, and align baselines by designing the
before and a�er paragraph spacing for different s�les to give totals that
are multiples of the Body Text line-spacing.

Footnotes and Endnotes

If you want notes at the end of the book, the entire book will have
to be a single story, with only the Table of Contents, title page, and index
as separate stories. Endnotes or footnotes can only be placed at the end
of the story or at the bo�om of a page, column, or text �ame. If you want
note numbering to be sequential throughout the book, and not restarting
for each chapter, a single story is also the best option.

If you want the notes at the end of each chapter, then each chapter
will have to be a single story, with endnotes at the end of the story, while
footnotes could still be at the bo�om of each page.

http://www.softerviews.org/Customising%20PagePlus.ppp
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The Footnote Text s�le1 is applied to footnotes, and the Footnote
Reference character s�le is applied to note index references in the text
and the footnote. If the font has an OpenType superscript feature, this
can be enabled on the Font Tab of the text s�le dialogue by editing the
Footnote Reference character s�le. Enable the “Use default OpenType
features” checkbox. True �����​scripts are slightly bolder than those generated
by using superscript forma�ing, and in the correct vertical position to
suit the font design.If the font has no superscript feature, the Character
s�le can be modified to use a different point size and a raised position
instead of superscript forma�ing.

In technical or academic publications that have many short footnotes,
they use far too much vertical space. It is possible to improve on this by
using the method described in my tutorial on Forma�ing Footnotes.
However, where there are only three or four footnotes per page, it is not
worth the ex�a effort. 2

On the last page of a chapter, if you want footnotes to be moved up
to just below the end of the text, the text �ame will have to be resized.
Currently, there is no way to automate this in PagePlus.

Contents and Index

Generating a Table of Contents is simple — insert a new text �ame
on a page where you want it to be generated, open the TOC Tab, and
select the paragraph s�les that you wish to include. Then set dot leader,
and hyperlink options, and generate it.

Before you can create an Index, you will need to mark all of the index
en�ies. This is one reason why I do not recommend using BookPlus.
Although an Index can be added to the last Chapter, or any chapter, using
BookPlus, adding index marks and editing the index are made much more
difficult by spli�ing the book into multiple publications. The index tab
in the index chapter does not display index en�ies in other chapters.

See my tutorial on Working with Indexes for more details.

1 Footnote text is based on the Body Text s�le, but uses a smaller point size. The small
text would look too widely spaced if Align to baseline grid were enabled, so it is disabled
for the Footnote Text s�le. In any case, footnotes are placed at the bo�om of the text
�ame, and usually have a separator line above them. Forcing them to fit the baseline grid
may not give a good result. 2 Use tab stops to indent footnotes.

http://www.softerviews.org/Formatting%20Footnotes.pdf
http://www.softerviews.org/Formatting%20Footnotes.pdf
http://www.softerviews.org/Formatting%20Footnotes.pdf
http://www.softerviews.org/Formatting%20Footnotes.pdf
http://www.softerviews.org/Working%20With%20Indexes.pdf
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Printing and Publishing

Unless you are printing the book on a desktop laser printer, you will
probably want to produce a PDF file. If it’s for the Internet, then you can
simply use the Web Normal or Web Compact PDF profiles. If it’s for
professional printing, then the Press-ready or PDF X-1a profiles are the
best to use. PDF profiles can be modified and saved for reuse to suit any
specialised needs that you may have. I use a custom PDF profile for most
of my publications that doesn’t downsample images because I carefully
optimise all images before placing them.

For PDF publications it is very helpful
to include PDF bookmarks. Although this
current book has a Table of Contents with
hyperlinks, once a link in a PDF viewer has
been followed, the TOC is no longer visible.

With PDF bookmarks, the book’s Table of
Contents is available at a glance in the
Bookmarks panel of the user’s PDF viewer.
From the Insert menu, select Insert PDF
Bookmarks, Automatic, and select the
heading s�les to included in the PDF Bookmarks, and the indent level.

Check that the automatically generated
bookmarks are in the desired order before
publishing the PDF again.

The Print/PDF Preview mode (on the
File menu) can be used to check how the
publication will look when printed, to
impose pages, or to allow for creep (moving
imposed pages apart or closer together when
creating staple-bound publications).

The Back Cover

This should not be an a�erthought. The back cover is o�en the
second thing that potential buyers will look at when browsing in a book
shop. As well as the publication details, a QR code, and ISBN number
if it has one, the back page can be used for some blurb about the book
and/or its author to get them to read further. Be concise, and give as
much thought to the design of the back cover as to the �ont.
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The author of this PagePlus tutorial, Bhikkhu
Pesala, has been producing Buddhist Publications for
twen�-eight years. Starting with “The Debate of King
Milinda,” using WordPerfect for DOS in 1988 he
continued using WordPerfect until at least 1993.

A�er moving to Chithurst House in West Sussex he used MS
Publisher 3.0, followed by PageMaker Classic (ver 4.0), then, later, he
used GST Pressworks for a short while.

He started using PagePlus �om version 9.0 (released 2003), and then
OpenOffice for its be�er Unicode support. However, a�er PagePlus 11.0
was released in October 2005 he switched back to using PagePlus. Since
then, every year or two, �om PagePlus X2 through to the latest version,
he has regularly updated his old publications and added new ones.

Buddhist publications require accents for Pāḷi words with macrons
above the vowels, ā, ī, and ū, dots below the consonants ḍ, ḷ, ṃ ṇ, and ṭ,
plus a dot above the ṅ and ñ tilde. Sanskrit words like śloka or Ṛgveda
require a few more Latin Extended characters, such as ś, ḥ, and Ṛ.

He started editing fonts �om Serif Font Pack with CorelDraw 3.0 to
add the required accents and additional tonal marks for the Chanting
Book produced for the English Saṅgha Trust at Chithurst. In 2002 he
abandoned these outmoded ANSI encoded TrueType fonts, and started
using a proper font editor, High-Logic’s FontCreator, which could edit
Unicode fonts.

In 2008, a�er reading this tutorial on the High-Logic forums he
started adding OpenType features to his fonts using FontCreator 6.0.
He later promoted the idea that Serif should support them.  In 2010,
Serif added OpenType support to PagePlus X5, and by 2013,
FontCreator 7 had support for adding basic OpenType features.

WebPlus X8 can now embed these custom fonts, but it doesn’t
support OpenType features.

Bhikkhu Pesala’s publications are available on www.aimwell.org as
�ee PDF downloads, and his OpenType fonts are available on his

So�erviews website. They are released under an
open GNU license to encourage co-operative effort
in developing and improving these valuable
resources for the benefit of all. The fonts have a very
wide glyph coverage, making them suitable for
Vietnamese and any European language. They
include many symbols.
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